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Preface



Microsoft Excel is the world's most used business intelligence tool. Its knowledge is even compulsory for an MBA degree and the business world depends greatly on it. 



This book is aimed at making you very good in Microsoft Excel for business data analysis, teaching you with companion videos and practice files that can be access at www.urbizedge.com/about (bottom of the page). It's intended for Sales Managers, Financial Analysts, Business Analysts, Data Analysts, MIS Analysts, HR Executives and frequent Excel users. 



It is written by Michael Olafusi a two time Microsoft Excel MVP (most valuable professional) and a full-time Microsoft Excel consultant. He is the founder of UrBizEdge, a business data analysis and Microsoft Excel consulting firm. He has trained hundreds of business professionals on Microsoft Excel and has used the experience gained from interacting with them both during such trainings and while consulting for companies to write this excellent guide for the busy professional who needs the improved work productivity Microsoft Excel provides.



If you feel any part of this book can be better improved or expanded, please send an email to mike@urbizedge.com 

Microsoft Excel: It’s more powerful and easier to use than you think!
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We’ve got Home menu, Insert menu, Page Layout menu, Formulas menu, Data menu, Review menu and View menu. Each of these menus will be discussed in practical terms.



The other menus — Developer menu, Load Test Menu and Power Query menu — are not displayed by default. I enabled them as I do a lot of programming and other advanced stuff in Excel which I need them for.



Home Menu



The home menu is Excel’s most used menu. It has very straightforward sub-menus.
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Clipboard: Allows you to copy, cut and paste in Excel

Font: Allows you to set font size, color, background color (fill) & turn on bold or italics or underline.

Alignment: Allows you to set the position of whatever you’ve typed (or copied) into Excel. It also allows you to set how it’s written: horizontal, vertical or slanting.

Number: Allows you to set how a number is shown in Excel: regular number, currency, scientific, percentage, fraction… 

Styles: Allows you to set the format of an Excel cell based on the data it holds (conditional formatting). It also allows you to convert a selection of cells to table, and to set quick formats for a cell.

Cells: Allows you to insert new cells, delete cells and change cell format.

Editing: It houses the very useful Sort and filter tools. And also Find & Select, Find & Replace. There’s also AutoSum which helps you sum all numbers in a selection.





Insert Menu



The Insert menu houses some of Excel’s best tools.
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Tables: Allows you to insert PivotTable, PivotChart and Table. Inserting a table in Excel allows for quick formatting, and better formulas (via named ranges). PivotTable and PivotChart will be discussed later.

Illustrations: Allows you to insert images and shapes.

Charts: Allows you to insert charts, which will be specially discussed later.

Tours: Houses Map which takes you straight to Power Map. Power Map is part of Microsoft’s new Power BI. It enables you make geo-maps and create amazing data visualization tours.

Reports: Lets you access Power View, another Power BI tool. Power View allows to create a data model, loading up many different databases and creating analysis that cuts across all the databases, allowing you to see insights that are beyond a single database.

Sparklines: Allows you to insert charts that fit into one Excel cell. They make some reports beautiful and easy to read.

Filter: Allows you to filter out field values you are not interested in.

Links: Allows you point a cell content to a website or an email address.

Text: Allows you to insert texts and objects (pretty much anything, including a PDF document)

Symbols: Allows you to type out equations and special symbols.





Page Layout Menu



The Page Layout menu does just that: setting up your Excel document’s page look and for printing.
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Themes: It’s not often used; it sets the look of the Excel window itself. 

Page Setup: It allows you to set how the page comes out when printed. Most used are the Orientation (to set as Portrait or Landscape) and Print Area (to select on the cells you want to print).

Scale to Fit: It allows you to set how much is printed per page. Most frequent use is to force Excel to print on one page, or fit all the fields (columns) on one page width.

Sheet Options: You wouldn’t want to change the default. It allows you set whether Excel gridlines be printed or not, and headings too. Default is no/off (unticked).

Arrange: It lets you rearrange overlapping objects (shapes, images, textboxes…). Or align them.





Formulas Menu



The Formulas menu gives you access to Excel’s built-in formulas.
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Function Library: It has the formulas grouped by category. Once you have an idea of what you want done, it helps you locate the formula to use. It’s good to look through it once in a while to have an idea of the out-of-the-box analysis Excel can do.

Defined Names: Lets you name a cell or selection of cells. Can be very useful when analyzing a big database or building a model.

Formula Auditing: Allows you to check for errors in your formulas, trace formula cells and see how your final result is being calculated.

Calculation: Allows you to set when the formulas in your Excel sheet are calculated: automatic (whenever a cell value changes) or manual (at first entry and when you force them to be recalculated).



Data Menu



The Data menu allows you to work with external data and do basic data formatting.
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Get External Data: It allows you to import or link to an external data file (non-Excel file). You’ll use it whenever you have a data in text file and need it worked on in Excel.

Connections: Allows you to make changes to the connections/links to an external data file. Or force a refresh of the connections to capture changes made in the external data file since last connection.

Sort & Filter: Allows you to sort data and do some filtering too. Filter allows you to specify values to display.

Data Tools: Allows you do very basic data analysis. Especially removing duplicate entries, and splitting one field into several (text-to-columns). Example is splitting full name into first name and last name.

Outline: Allows you to group (and hide) several rows. Useful for large data reports with few categories; helps to group categories.

Analysis: This is only visible after you enable Data Analysis add-in or Solver add-in. It allows you access a large collection of statistical analysis tools and modelling.



Review Menu



The Review menu is for spell checks, commenting and setting access restrictions.
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Proofing: Allows you to carry out spell checks and word meaning checks.

Language: Allows you to translate the Excel file content from one language to another.

Comments: Allows you to include comments in an Excel sheet, view all comments at once or delete comments.

Changes: Allows you to set access restrictions and track changes to the Excel file. Also allows you to share the file.



View Menu



The View menu allows you to change the window layout of the Excel document. It doesn’t change anything in the actual document, just the way it’s displayed.
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Workbook views: Allows you to set how the workbook (Excel file) is displayed.

Show: Controls what non-printing details are shown: Gridlines, Headings, Formula bar and Ruler. The one you’ll be interested most in is Gridlines. If you want your Excel sheet to look more like a Word file, untick the Gridlines. That’s what’s done to every Excel sheet you see that has no Gridlines.

Zoom: Does what it says: sets zoom.

Window: Allows you to freeze headers so when you scroll they will never be out of view. And also allows you to split the Excel sheet display, so you can compare two different parts of the sheet.

Macros: Allows you to see the macros programmed in the Excel file (if there’s any macro in it). Shows only when the developer menu is enabled.

How Excel Handles What You Type



In Excel, you type into small rectangular boxes called cells. I would be referring to everything you type or copy into Excel cells as Data. 



Every cell has an address, because each cell is an intersection of a row and a column. The cell selected in the image below, is addressed as cell A1. It is the intersection of column A and row 1. A collection of millions of these cells make an Excel sheet. And an Excel file (also referred to as Excel workbook) is a collection of one or more Excel sheets.
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Sometimes, what you type into a cell takes more space than the cell has. Don’t worry, just expand the column width by dragging the right border of the column header.



Like this:
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Different Data Types in Excel



Excel recognizes 4 different data types: Text, Number, Boolean & Formula. Anything you type into Excel will fall under one of these.



Text: Whenever you type alphabets, or a mix of alphabets and numbers into Excel (without proceeding with =), everything is recognized as text. By default, Excel aligns text to the left of the cell.
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Number: If all you type into a cell are digits, they are recognized as Number by Excel. By default, Excel aligns number to the right.
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Boolean: FALSE and TRUE are Boolean entries. You’ll hardly use them. They are used for setting up complex formulas. By default, whenever you type false or true in a cell, Excel will put it in upper case and align it to the center.
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Formula: Once you begin a cell entry with =, Excel treats everything you type after as a formula. 
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As a recap, see the image below.
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The practical importance of this is that if you receive a sales report in Excel and the numbers are aligned to left instead of right you should be concerned. There are three reasons this can happen and two of those reasons will cause some of your mathematical formulas to not work correctly. You wouldn’t want to do an incorrect analysis, so it’s best to check why the numbers are aligned to the left and not to the right as expected.



	It could be that the author forced the numbers to align to the left. To find out if that’s the reason, check the alignment under Home menu.
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	It could be that the author forced the number to be treated as text by setting the cell format to text
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	It could be that the author preceded the number with a single apostrophe (’) before typing the number. This is a trick savvy users use to force Excel to keep the zeros at the beginning of your phone number or bank account number. Unfortunately, it forces Excel to treat the cell entry as a text and align it to the left.
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Out of these three ways of making a number show as aligned to the left, only the first one leaves the number intact. The other ways transform the number to text and will give you issues when you include them in calculations that normally would work on numbers.



Now you have an idea of how useful an understanding of the default ways Excel treat the different data types can be in your day to day use of Excel.

Data Consistency, starting with the end in view

Excel is different from every other Microsoft Office program you use. Most of the documents, reports and analysis you do with Excel will be used some day in the future for another report or analysis.



To become an expert in Excel, you have to always work with the end in mind. You have to create your Excel documents in such a way that you can easily use them for some bigger reports in the future. And there are some general rules I'll recommend you work with to achieve this.



1. Always use a compact table structure for entering you core data in Excel. This means using the minimum number of rows and minimum number of columns. Example of a compact table and non-compact table is shown below:
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Same table but not compact, shown below.
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In the non-compact table example, you can delete rows 37 and 38 without deleting any data in the table.



2. Use descriptive names for your column headers and row headers.

Be as descriptive as possible in naming the fields in your table, make it easy for anyone who will view your table to understand the information it convenes.



Below is a table with field names that are descriptive enough for anyone to understand the information the table convenes.
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Below is a table that has headers that are not descriptive enough. It’s hard to figure out the specific information in the table. Is it a table of revenue or expense? Are the companies clients or suppliers? What year do the months represent — January 2014 or January 2015? Whomever you send this report to will call you back for a detailed explanation of what you intended to report.
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3. Name your Excel sheets

Don’t just go ahead with the default names — Sheet1, Sheet2, … — rename the sheets to reflect the contents of the sheet. This makes your work better organized and future use more convenient.



[image:  ]



To rename a sheet, right click on the sheet name (the default names are Sheet1, Sheet2, …) and select rename. And as you see above, you can change the color from the default too. 
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4. Also use descriptive names when renaming the Excel sheets.
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5. Avoid putting too many tables in one Excel sheet. Best to keep just related tables in the same sheet if you must put more than one table in the sheet. It makes naming the sheet easy and straightforward.



6. Use same naming conventions and table structure across all similar Excel files, especially weekly, monthly and yearly reports of the same data.



7.  Don’t use CAPS excessively. It makes your reports very unprofessional.

Building Datasheets that can easily scale



Occasionally, you will have to work on a table whose data grows continually. We can refer to such tables as datatables. All tables hold data and can technically be referred to as a datatable, but in this book we will refer to all tables as just tables and limit the term datatable to only tables that grow perpetually. 



An example of such a table is an Employee Record table. As long as the company exists the table will keep growing and even if the company aims to not have over a 100 employees, there will always be old employees leaving and new ones taken to replace them. And they all have to be captured in the employee record table, no employee’s record is deleted when he leaves, there’s only a field added to capture his resignation.



There are some peculiar ways of treating a datatable.



1. Have only one datatable on a sheet. Since a datatable is a table you expect to grow over time, having only one on a sheet lets you have access to all the rows and the columns in the Excel sheet.
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2. Start a datatable as close to cell A1 as possible. Again, this is to afford you the maximum space in the sheet for your growing table.



3. Avoid meaningless gaps in the datatable. Make it as compact as possible.



4. Arrange the fields such that the most important or basic fields come first. For example, in an Employee record table, name should come before contact address.



5. Have a field for every meaningful chunk of data. It is better to have separate fields for first name and last name than have one field hold both.



6. Avoid merging cells in a datatable. It is better to repeat cell entries than merge the cells. Merged cells aren’t formula friendly.



And as a bonus, avoid hiding rows and columns in the datatable. This will save you a lot of future headaches.

Sorting

Sorting is one of the most frequent task we do in Excel. Sorting lets you re-arrange data in alphabetical order, lowest to highest, highest to lowest, and even by cell color.



We are used to having data arranged in a particular order — A to Z, January to December, 1 to 10, and so on.



Below is an example of a table that has its records haphazardly arranged. The states are not arranged alphabetically and the months are not in the natural order.
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First, let’s have the data sorted by State alphabetically 



Below are the recommended steps to sorting a table. Select the table, go to the Home menu and click on Sort & Filter.



[image:  ]



The sorting dialog box comes up.
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This dialog box allows you to add more than the default one level of sorting. 



Select “State” in the Sort by box and A to Z in the Order box.
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The result is shown below.
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You can add an extra level of sorting in the sorting dialog box. This would be useful in sorting tables like a national population census table. You might want to sort first by state (from Abia to Zamfara) and then an extra level of sorting by Local Government Areas. So you’ll have a setting similar to the one below
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Next is to sort the months in the natural order we are used to — Jan to Dec. This will require a type of sorting called “Left to Right” as against the one we just did, called “Top to Bottom”.



So to get this done, we select the table starting from the first month to the last month. We will leave the state field out because we want it to remain in the position it is.
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Then select the row the months are on (Row 2) and set the order to Oldest to Newest.
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Below is the result.
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Filtering



Filter is one of the Excel power user’s most used tool. It allows you selectively choose what you want to view in a table and hide the rest.



It is very easy to access and can be accessed from three different places in Excel.



By right clicking and selecting Filter.
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From the Home menu, clicking on Sort & Filter at the right.
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From the Data menu.
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Once you’ve turned on the Filter tool by clicking on it, you will see a dropdown box beside the headers of the table.
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Clicking on the dropdown box shows you all the unique items in that field and you can select the ones you want to view (hiding the rest). By default, all items are selected so you will have to unselect the ones you don’t want to see.



In the screenshot below, all the pizza items were unselected except the BBQ Chicken (meaning only BBQ Chicken was selected).
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Notice the blue row numbers, it is Excel’s way of visually hinting you that some rows have been hidden as they did not contain the items we want to view.



Filtering is that simple and straight forward.



Data Cleaning



A lot of times the data you are given to work on in Excel is not in a format usable for you and need some cleaning before you can go ahead with the analysis you intended doing on it. In most cases you have to manually clean the data and fix whatever issues it has one by one before progressing with the original analysis you intended to do on the data.



Fortunately, Excel has some nifty tools to help you automate some of this data cleaning process. The most common ones are,

	Removing duplicates, and

	Text to Columns


Then we’ll cover a special tool that can help you do a quick categorization of your data: Subtotal. Finally we’ll cover Data Validation, an ingenious tool for reducing data entry errors in your Excel files.



Removing Duplicates.



Occasionally, you will have a table and you’ll want to remove duplicate entries. If it were a sales transaction table, you might want to remove the duplicate sales entries. In the example below, it is a table of items (Pizzas) and we want to remove the duplicate entries leaving only unique entries.
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As illustrated above, you select the entire records first and then go to Data menu, click on Remove Duplicates. You will get a confirmatory dialog box. Click on OK.
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You’ll see a result showing the number of duplicate values that were found and the number of unique values found. Basically, what Remove Duplicates does is it leaves one record of each item and removes all the extra record for that item that it finds. 
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When you select a table with more than one field entry, the Remove Duplicates remove only the entries that have same value in all the fields as a previous entry except you specify which fields to exclude in the search for duplicates.



In the screenshot below, we excluded Car Sales from the fields to include in the search for duplicates. So rows that have the same entries in all the other fields will be deleted except one.
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Text to Columns



There will be times you will have data you would prefer split across multiple columns squeezed into one column. This happens a lot when you copy data from an external source into Excel or you open an exported data from other business software like CRMs and ERPs.



Excel’s Text to Columns tool is the magic tool for splitting such data entries into multiple columns provided there is a recognizable character separating each field or they have fixed lengths per field. Below is a simple example for splitting a full name in one column to first Name column and last Name field column.
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Delimited is the option to specify that there is a recognizable character separating each field. In this example, there is a space separating every first name from the last name.
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Notice how Excel shows a line between the first names and the last names once you select the appropriate delimiter (space, in this case). Click on Next and Finish.
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Below is the result. Just as desired.
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Subtotal



Subtotal is a secret tool for doing a quick analysis of a table in Excel. It breaks the data down by categories and creates grouping that shows you different levels of details.



It is also very easy to use.



Below is an example where we’ll use it.
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It is a market research data table showing the different car make sold in three different auto dealerships.



We can apply a subtotal to this to see some interesting analysis.
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Select the table, go to Data menu and click on Subtotal. In the dialog box that comes up, in the “Add subtotal to” section tick all the fields that have numeric values (except you don’t want to see a numeric analysis of them).



Once you click on OK, you get a result that looks like the following —
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Level 1:
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Level 2:
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Level 3:
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And the best part is that you can remove the subtotal and have your original table data back just as it was before. To remove is as easy as clicking the Subtotal again and clicking on Remove All.
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See the result below. All the level 1, 2 & 3 groupings gone.
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Data Validation



This is another secret but powerful tool in Excel. It helps you put in place some error check mechanism and can be used by a skilled Excel user to make powerful Excel dashboards.



Let’s see some of the common uses of it.



The table below is an Employee records table. In it we want to force people to enter just departments specified at the left of the table. In fact, we want them to have the easy option of seeing a pre-populated dropdown list and pick a department from the list options.
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We select the cells we want to give this functionality, go to Data menu and click on Data Validation (sometimes twice).



[image:  ]



You’ll see that there are many options to pick between.



	Any Value. This is the default and it is same as not having any data validation. The user can enter any value into the cell.

	Whole Number. This forces the user to enter only numeric values that are whole numbers. If the user enters a text or decimal entry he’ll get an error. This might be applicable in an invoice sheet, for the cells that hold the order quantity if you don’t sell fraction of your products.

	Decimal. This forces the user to enter a whole number or decimal entry. A whole number is same as a decimal with zeros after the decimal point. This might be great in a financial model sheet, to hold values of growth assumption, exchange rates and risk premiums.

	List. This is the one we are most interested in. It enables us to limit the cell entries to a list of options. We will use this in the example under review.

	Date. This forces the user to enter a valid date entry.

	Time. This forces the user to enter a valid time entry.

	Text Length. This allows the user to enter any value as long as the character length is not more than the specified value here. It is good for fields that hold phone numbers, maybe you want to limit the entry to the +2348123456789 14 characters long entry format.

	Custom. Just as the name specifies, you want to limit the cell entry to something less conventional and not covered by the other options.




In this example we are going to use the List option. So let’s select it.
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Once you click the icon on the far right corner of the Source box, select entries to limit the users to. In this case we have typed out the list options in cells G2:G6, holding the different departments.
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And it’s done.



The user is forced to choose between the options in the list. He even sees a dropdown arrow that expands to a dropdown lists the moment he tries to fill the cell.
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And that is how Data Validation works. When used creatively it can save you from the stress of making corrections to forms people filled and can be used in conjunction with formulas like VLOOKUP to make a dynamic report and dashboards.

Data Formatting



There are some quick tips in Excel that would turn a bland looking data into a nice looking one. One of the best tip is to apply a table formatting to the data.



An example, is taking a table like the one below and turning it in a well formatted one.
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Select the data and go to Home menu, Format as Table. Choose a color theme.
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If you want to email the Excel file to a colleague, you can copy the table and paste in Outlook and you’ll have the beautiful looking table in the body of the email. Your colleague will have no excuse to give regarding not seeing or acting on the data.



[image:  ]





So what if you needed to print it for your boss.



Here’s what you get from Print Preview.
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So how can you make Excel print this table on just on paper?

Very Easy.



Go to Page Layout menu, and under the Scale to Fit section, set the Width and Height to 1 page.
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So let’s see the result.
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Goal achieved! But it could have looked better if it had used more space, the space below. So we need to try out one more setting and see if it will give us a better result. We will set the Orientation to Landscape.
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Let’s view the result.
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Bravo! This is much better!



What if the boss wanted just January to May data and not the entire table?

Also very easy. 



Highlight the table from the beginning up to May, leaving out June. So we are highlighting just what we want to print.



Under same Page Layout, Click on Print Area, and select Set Print Area.
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And that’s it! So let’s see the result.
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There we have it, no June data included!



One more big tip. 



What if you have a big table that will print onto many pages but you want the header to repeat on the first row of every page?



Below is a sample.
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Notice that the page two has no header to help you identify what the fields are.



So here’s how to fix that.



Still at Page Layout menu, click on the small icon at the bottom right corner of the Sheet Options section.
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In the dialog box that comes up, set the Rows to repeat at top
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Select Row 1 that has the headers.
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And that is all!



So let’s see the result.
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Done.



So these are the basic ways you format your data for printing.



Charts



Excel 2010 has 11 main chart types.



[image:  ]



Excel 2013 and Excel 2016 have 10 main chart types. Actually, 9 If you take combo chart as a combination of two or more other chart types.
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But in all you will end up using majorly,

	Column chart

	Line chart

	Pie chart, and

	Bar chart.




So let’s focus on these four charts.



Column Chart and when to use it.

Column chart is used to visualize data across different categories. An example is revenue across the four different branches of a company.
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So how do you turn a boring data like this:
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Into a beautiful insightful chart like this:
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It is very easy.



Select the table data you want to make a chart of and go to the Insert menu, click on the Column chart and select the 2D Clustered Column chart (the first option).
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You will get a chart that looks like the one below. Not bad looking, just needs a little formatting to make great.
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Click on the chart, and the context based menus will show up on the Excel menu bar.
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Go to the Format menu and choose a formatting you like for the entire chart. If your company’s corporate color is red and purple, you might want to make charts that reflect that brand color.
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See the result red border white fill format.
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You can also change the chart background color.
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Also you can change the color of the bars by clicking on them and choosing the color you want.
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And this is the final result.
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It looks better than the default and reflects your company’s corporate color. Just that you might want to not use the red border. Most professionals argue that it’s best to not use any border or background, just make only the important things obvious – data bar and the axis label. I suggest you do whatever looks great to you. This is not an exam and most likely what will look good to you will look good to your colleagues whom you’ll share the report and charts with.



If you try out other color schemes you can end up with charts looking like the one below.
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The extra step we took besides removing the red border and changing the bar color to bright blue is to change the chart area background to white.
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And that’s basically how you insert and format a column chart. You can try inserting a 3D chart too for the same data. Follow the same steps but choose a 3D chart instead of the 2D we earlier used. And when you do the extra formatting already explained to you, you can end up with a beautiful chart like the one below.
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Finally, you can insert other elements on the chart like the data table, as shown below.
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The result is shown below.
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You would have noticed that there are other column chart types besides the Clustered one we selected (the first option).
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As numbered in the image above, they are

	Clustered Column

	Stacked Column

	100% Stacked Column




The clustered column is what we have used so far. It’s straightforward to understand. The stacked column is useful for showing the breakdown of the data that makes up the bar. Below is an example of its use. We are going to breakdown the revenue by the products that contributed to it.
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To do this stacked column chart, you simply select the entire table data, including the breakdown by products and choose the Stacked Column chart. And as you can see, it shows a breakdown of each bar by the constituting parts (products in this example)



The third one, 100% stacked column, is just slightly different. Rather than show you the breakdown by product revenue values, it shows the breakdown by the percentage contribution each product makes to the total. Below is the 100% Stacked Column output for the same data.
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 Line Chart and when to use it.



Line chart is used to show trend, usually over a time period. An example is if you want to show the trend of how the company’s revenue has been growing for the last five years.
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You create a line chart of a table in a similar way as we did for the column chart. You select the table’s data and go to insert menu, click on the Line chart type you prefer.





[image:  ]





Again, Excel does a fairly good job and you can easily improve the format of the chart using the steps already explained.
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Pie Chart and when to use it.



Pie chart is used to show the contribution of each category to the pie that represents the grand total.



Below is an example showing the breakdown of Nigerian population by region. You can see how the Pie Chart makes it easy to see the contribution of each region to the total population of Nigeria.
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It is extremely easy to make. You, like for others, select the table’s data and select Pie Chart under the Insert menu.
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Excel does a default pie chart that you can greatly improve.
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Bar Chart and when to use it.

Bar chart is technically the same as Column chart. The difference is that when you have a table with lots of entries, usually over 8, you are better off with using a bar chart rather than the column chart. Also when the entries have long label names, it’s better to use bar chart even if the entries aren’t many.



Below is an example.
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The same rules about Stacked and 100% stacked apply to bar chart and, even, line charts.



Combo Chart



Occasionally, you will have to combine two or more chart types in one visualization/graph. This is very useful if you want to show two interconnected data and their combined relevance.



An example is showing how a company’s revenue has been changing in values and as a growth ratio. 
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In Excel 2013 and Excel 2016, it is very easy to make.



Just select the entire table and insert a combo chart. It can be easily located under Recommended Charts.
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PivotTable and PivotChart



PivotTable is Excel’s premium tool for working with huge data table and even data stored in other database systems like Access, SQL servers and MySQL servers.



Below is an example of a large data table we will use PivotTable on to do some very relevant quick analysis. It is a table of sales for a particular Pizza Restaurant for a day and it has 5000 entries.
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So how can we make a report that will show us the sales performance that day by the different type of Pizzas the restaurant sells.  A report like the one below:
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It’s quite easy with Pivot Table.



You start by selecting the sales transaction table or selecting one of the cells in it. Then go to Insert menu and click on Pivot Table.
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In the screenshot above, I selected one of the cells in the table, clicked on Insert menu, clicked on PivotTable, confirmed that my entire table has been selected and clicked on OK.



You will be taken to a new sheet that looks like the one below:
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At first it looks really different, like you are no longer in Excel. But it is very easy to work with. The core part is the part on the right with the name PivotTable Fields. It has a list of all the fields in the original data table. The part below the field names are where you actually set up your report.



Whatever field you want to display its unique entries, one per line/row, you will drag to ROWS. Let’s do that for the Pizza Sold field so we will be able to see all the pizza types the restaurant sells.
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Then if it is that you want to display those unique entries one per column, drag the field to COLUMNS. Let’s see what will happen if we drag that Pizza Sold field from ROWS to COLUMNS.
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So now you understand how ROWS and COLUMNS work. 



Drag Pizza Sold back to ROWS, that is where we need it for our quick analysis.



Next is VALUES. Whatever you want to do a mathematical calculation on, you drag to the VALUES part. Common calculations you will find yourself doing are counts (to see the number of time each unique entry occurred in the original table), sum (to add the values a particular field) and average (to average the values of a particular field).



In our case, let’s drag Quantity and Amount Sold fields to VALUES.
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Can you see how quick this is? We have just analyzed a 5000 sales record table in seconds. Now we have a report that shows us how many of each Pizza type was sold and the total sales amount generated.



Those are the type of lightning fast analysis PivotTable allows you to do.



There is now one part we haven’t touched: FILTERS. As the name suggests, it simply gives us the capability to filter our report. We will drag Time Range to FILTERS to see which sales occurred at the peak period (before 9:00am) and after the peak period.
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And that’s how PivotTable works. Very easy to use and powerful.



PivotChart



Whenever you insert a chart using data generated via a PivotTable, that chart is a PivotChart. It has some extra functionalities it inherits from the PivotTable which makes it a little different from the regular charts we have already discussed.



Below is the PivotChart for the PivotTable we just created.
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Notice the extra elements on it. Even the Time Range filter is showing on the chart. Besides those extra elements, a PivotChart is same as the regular charts and the same kind of formatting you can do on the regular charts work on PivotCharts.

Business Data Analysis



When using Excel to organize or analyze your business operations data, there are some tools you need to be aware of.



Linking Sheets

 

You often have to pull data into a report from another report or Excel file, the most effective way to do this is to link the sheets. You will be mirroring the value in the source sheet in your destination sheet. 



An example is if there is a sheet that contains the internal revenue of all the states in Nigeria and you are doing a report on Kebbi state. You want to pull the values for Kebbi state from the sheet that has everything (source sheet), your best bet is to link the sheets. It is preferable to copying the values from the source sheet because if the source sheet is updated with new values your analysis sheet will not automatically update (will still be showing the now incorrect old values). So how do you link sheets?



[image:  ]



[image:  ]



It’s very easy. In the fields in the analysis sheet, for the different months values you will type = and select the cell with the actual figure in the source sheet.



In the end you will have the following or similar:
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The source sheet has the name Datasheet, hence the =Datasheet!B25 in January value cell in the analysis sheet. You don’t type anything beyond = into the values cells in the analysis sheet, once you select the right cell in the source sheet, Excel will write everything you see in the cell.



Duplicating Sheets



Sometimes you will want an exact copy of a sheet to work with or email to someone (especially if the Excel file contains other sheets you don’t want the person to access). Excel has a nifty tool for duplicating sheets. And it’s very easy to use.



Right click on the name of the sheet you want to duplicate. Click on Move or Copy…
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You’ll see a dialog box. Select new book and tick Create a Copy.
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And the sheet will be duplicated in a new Excel file for you.
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Inserting Sheets, Renaming Sheets and Changing Sheet Tab color



You can insert a new Sheet in an Excel file. Just click on the new sheet icon at the right of the last sheet tab in the file.
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You can also rename the new Sheet to what you want. Just right click on the sheet tab and select Rename.
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Finally, you can give it the color you want. Again, right click on the sheet name and click on Tab Color. Choose the color you want.
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Freezing Panes



There will be times you have a table to with lots of entries and will require a lot scrolling up and down, and even left and right. Often you will want some part of the table to never scroll out of view. This is usually the headers. Achieving this requires enabling a tool called Freeze Panes.



It freezes the part of your report you don’t want to scroll out of view. Below is an example. You access it from the View menu.
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There are three options:

1. Freeze Panes. To use this option you have to select a cell in the table. This option will freeze all the rows above the cell you selected and all the columns to the left of the cell you selected. So you have to select just the right cell. If you want to freeze rows 1 and 2, then you will select cell A3.

2. Freeze Top Row. This freezes the top row in your Excel’s current view.

3. Freeze First Column. This freezes the first column in your Excel’s current view.



Below is the result of freezing row 1. It doesn’t scroll out of view even when I scroll way down.
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Splitting Windows



Excel lets you split your current Excel view into two independent windows that you can scroll separately. This is useful if you want to monitor changes in two different far away parts of your Excel file that are dependent.



An example is shown below. The Excel file is a stock analysis file and at the top far right are projected values based on assumptions made far down the Excel sheet. So in order to see instantaneously the effect of a change in an assumption on the projected values, splitting window was used.
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And the assumptions far down
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Splitting window allows us to view this two far away parts of the Excel sheet at once.



To do this, select the middle row in the Excel sheet and go to View menu and click on Split.
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Then scroll the section below the splitting point down to the assumptions part. It will scroll independent of the part above the split line.
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Notice the jump from row 10 to row 104. 



Now whenever you alter the assumptions you won’t have to scroll up to see the effect on the projected revenue and projected profit.



Conditional Formatting



Conditional formatting is another power tool in the power Excel user’s toolbox. It allows you to indicate the relative performance of metrics (KPIs). Below is a simple example of its use.
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Notice the green, yellow and red arrows. They are conditional formats that let you visually see where you are spending below your budget, where you are spending exactly what you budgeted and where you are spending above your budget.



Those are type of practical visual analysis conditional formatting provides.



You can access it via the Home menu. And it has the following formatting groups.
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Power Excel Formulas



Excel has thousands of formulas but a select few stand out as very versatile and useful for day to day business data analysis and reporting. We are going to focus on those formulas in this section.



VLOOKUP



This is perhaps Excel’s most popular function. In interviews it is used to sieve the power Excel users from the occasional Excel user. Its popularity lies in its ease of use and capability to get you the data you need from another table if you provide it a clue. 



Below is an example of its use.
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The formula breakdown is 
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Lookup_value

=VLOOKUP(A2,A5:G24,2,FALSE)

Basically, it is asking you for the clue you have. What piece of information do you have that I should look for in the table that has everything.



Table_array

=VLOOKUP(A2,A5:G24,2,FALSE)

Where is the table that has everything? So here you are selecting the table that has everything.



Col_index_num

=VLOOKUP(A2,A5:G24,2,FALSE)

When I see the clue, what data should I bring back? That data is in what column counting from the leftmost column in the selected table.



Range_lookup

=VLOOKUP(A2,A5:G24,2,FALSE)

If I am unable to find the clue, should I take a guess? Usually, you wouldn’t want Excel to take a guess, that could cause you trouble. So say no by typing FALSE.



And that is how VLOOKUP works. It will look through the first column in the table you selected for the clue that you provided and when it finds it, it will bring back the data you specified for it to get.



It makes a lot of reports easy to do and very helpful with making dashboards.
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IF



IF is arguably the most powerful function in Excel. It can do almost the impossible. And it’s only limited by the creativity of the user.

It allows you to check for a condition and specify what should be done when the condition is met and also what should be done when it is not met.



Here is the structure.
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In the example above, we have specified a condition that only when the salesman makes more than 1 million naira worth of sales should he get the sales bonus of 5%. If he fails to meet that condition he is not entitled to any sales bonus.



COUNTIFS and SUMIFS



These combine an inbuilt if function with simple functions like count and sum. 



A relevant example is the Pizza Sales record we used for PivotTable. We could have generated the same analysis without PivotTable by using the COUNTIFS and SUMIFS functions.
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For the Count of Sales, the COUNTIFS structure is
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This will count cells between range B1 and B5001 where the cell entry is equal to the G3 value (BBQ Chicken). And it was replicated for the other pizza types.



For the Sum Of Sales Amount, the SUMIFS structure is
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It will sum values in cells C1 to C5001 where the cells in B1 to B5001 has cell entry equal to G3 (BBQ Chicken). 



AVERAGEIFS

AVERAGEIFS is similar to SUMIFS. Generally, I think it is much less used than SUMIFS. In my several consulting jobs for clients I have used more of COUNTIFS and SUMIFS than AVERAGEIFS. It is particularly useful in performance analysis. An example is if you are a stock analyst and you want to find the profit margin for a particular industry. You will need to use AVERAGEIFS to specify which companies to include in the computation of the profit margin, and statistically, you can’t count or sum the individual profit margins, you have to average them.



Below is an example we’ll use for illustration.
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So how do we find the profit margin performance for the Airline Industry? We have to use AVERAGEIFS.



Here is how it works: =AVERAGEIFS(average_range, criteria_range, criteria)



The average range in our case is the Profit Margin field. That is where the profit margin values we want to average are. 

The criteria range is the Industry field. It is where we will identify the companies that fall under the airline industry.

The criterion we are looking for is Airline. But remember to put it in double quotes. All texts in a formula must be in double quotes.



The resulting formula will be: =AVERAGEIFS(C1:C22,B1:B22,"Airline")
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IFERROR

A lot of times your formulas in Excel will generate an error. It could be for reasons beyond your control: a missing record, wrong value type or a problematic entry. IFERROR lets you trap errors and display something more meaningful or less annoying than the cryptic error entry Excel gives you.



Its syntax is: =IFERROR(value, value_if_error)



An example to illustrate its use is given below.
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Notice that we have no value for Enugu state and it is generating an error in the %age value field. It would be nicer to have left a blank space or a hyphen instead of an error code in the Enugu row.



IFERROR can help us with that. And here is how we would do it.



[image:  ]



=IFERROR(B5/$B$9,"-") which is simply telling Excel to calculate B5/$B$9 and if the result is an error it should put a hyphen in the cell instead of an error code.



CONCATENATE

Concatenate lets you join entries in different cells. 



The syntax is =CONCATENATE(text1, text2, …)



A clear example is what we have below.
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How do we join the First Name and Last Name to get the Full Name?

This is what CONCATENATE does for us.



[image:  ]





[image:  ]



But there is a small problem: no space between the first name and the last name. How do we fix this? 



CONCATENATE can handle that. You are not restricted to joining cell entries. You can put in your own text and that’s what we will do to fix the problem we have. 
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We have added a space between the first name and the last name. We added it as a text entry, hence the double quotes encapsulating it.

=CONCATENATE(A2," ",B2)
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And that’s how you can join different cell entries using CONCATENATE.



I’m sure you are wondering why the formula had to be a long name one. Well, there is a very short alternative operator: &.

We can simply join the different cell entries by putting an ampersand (&) between the entries. So replacing our long formula, we will have: =A3&" "&B3
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Great, right?



All that is left is to drag the formula down for the other entries.
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LEFT, RIGHT and MID

There will be times you need to extract a portion of a cell’s entry. A practical case was a template I built for a telecoms company to determine the least cost partner to use for each international call destination. So I had to use a formula to pick out the country codes and check which provider is the cheapest to use to that destination. 



I have prepared a sample data for a simple illustration. It is the matriculation number of the university I attended. It is a clever combination of department name, year of admission and candidate number.
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The first three characters are the department acronym. The two digits sandwiched between two forward slashes are the year of admission and the last four characters are the candidate number.



We are going to use LEFT to extract the department name, RIGHT to extract the candidate number and MID to extract the admission year.
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It is a very easy to understand formula: =LEFT(A5,3). You simply specify the cell you want to extract from and specify the number of characters you want to extract starting from the leftmost character.

In this example, it’s three characters we want to extract starting from the left (beginning of the cell entry).



Now let’s proceed to extracting the candidate number. This time we want to extract starting from the right, four characters. So we will use RIGHT.
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=RIGHT(A5,4)

Also very easy to understand.



Finally, let’s extract the admission year. It requires the MID formula. It’s a little not easy to grasp like the LEFT and RIGHT. It requires that you specify the starting point for the extraction. The concept is very easy to understand, the part that trips a lot of people up is how the starting point is determined. You have to count from the first character (from the left) to the first character you want to extract. 



In this example, we will count till the first character of the year. It is the character number 5. Then you’ll proceed to specify the number of characters you want to extract (2 in our case). 
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=MID(A5,5,2)

A5 is the cell we are extracting from. 

5 is the starting point.

2 is the number of characters we want to extract.



TODAY, DAY, MONTH and YEAR

Excel allows you to do a lot on dates. There is even a formula to call up today’s date; it is aptly named TODAY(). You have to enter the brackets.
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Then you can extract the day of the date, the month of the date and the year of the date very easily.
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=DAY(A3)

=MONTH(A3)

=YEAR(A3)

A3 is the cell that has the date. And it works on dates you manually type or copy into Excel and not just the ones we use a formula like TODAY() to generate.



Finally, Excel lets you choose how a date should be displayed. Right click on the cell housing the date and click on Format Cells.
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You can specify how it should be displayed.



UPPER, LOWER and PROPER

Ever tried changing a text from upper case to lower case in Excel? Too quickly people give up and conclude that it’s not possible in Excel. Well, Excel has that functionality but as a formula.



UPPER converts a cell entry to all upper case.

LOWER converts a cell entry to all lower case.

Proper capitalizes the first letter of each word in the cell.
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A1 is the cell entry we want to change the caps of.

See the results of the UPPER, LOWER and PROPER formulas below.
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RAND and RANDBETWEEN

Wondered how I generated all the data I have been using for illustrations? Well, I used RAND and RANDBETWEEN for most of the numbers and even some of the texts (in conjunction with a magic formula called INDIRECT).



RAND() generates random decimal numbers that are greater than 0 but less than 1. Essentially, decimal numbers between 0 and 1 (0 and 1 non-included).



RANDBETWEEN(bottom_number, top_number) generates numbers between the bounds you specified as bottom and top.



Below is a relevant example. I have used the formulas to generate sales number and profit margin.
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Named Range, Goal Seek and Scenario Manager

Excel has some what-if-analysis tools that greatly help with business decision analysis. You can easily simulate effect of changes in circumstances on your business projections and create compelling business case analysis. 



Named Range

Excel lets you name a cell or a selection of cells. It’s very useful when you are building models in Excel as it makes the model formulas easy to write and troubleshoot. 



They are two ways to create a named range and I will start with the very quick and easy way.



Just select the cell or group of cells you want to name. Go to the name box and type in the name, replacing the cell address in the name box.
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We’ve successfully named all the Imo state revenue values as Imo. As benefit number 1, we can use it in a SUM formula instead of highlighting the entire range.
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Another advantage will become obvious later when we do Scenario Manager.



So what is the second way of creating a named range?



It is, in fact, the standard way. It’s also the only way that allows you to edit an already created named range.



Go to Formulas menu and click on the Name Manager.
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You can create new named range, edit already created ones and delete a named range.



GOAL SEEK

Goal seek is one of those powerful but seldom used tools in Excel.

It allows you to set-up a small model and tell Excel to optimize it for you based on one variable input and one set output. It’s the perfect introduction to a model and linear programming in Excel.



Let’s a simple and common use case. Below is a loan calculation table. Let’s say I have found a huge business opportunity in large scale cocoa farming and I want to borrow N100 million from the bank. And the table below is the conditions the bank gave me: a payment period of 10 years and annual interest rate of 24%.
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Excel has a formula for calculating the annual payment amount.
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So I go and check my business financial projection, and find out that I can only afford to make N20 million annual payment. What rate will I negotiate with the bank? 



This is where Goal Seek comes in. We simply tell it to find out what interest rate will evaluate to N20 million annual payment.



To access Goal Seek, go to Data menu and What-If-Analysis.
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I set payment amount cell to N20 million and tell Goal Seek to vary the interest rate.



Once I click on OK, it does a series of iteration and gives me the result.
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I should ask for 15% annual interest rate.



Scenario Manager

Scenario Manager is one of Excel’s decision analysis tool. It allows you compare outcome for different business scenarios.



Below is a practical business use case of the scenario manager. It is taken from our business circumstance and you’ll find it very interesting.



We run a Microsoft Excel and Business Data Analysis business. Our major income streams are consulting for big multinational firms on data analysis and business process automations, and Microsoft Excel training. So let’s say we decide to run a special one day Microsoft Excel training. It was specifically my idea. I had stumbled on a training advert on Punch newspaper. A one day training at VCP Hotel and costing N80,000. So I felt we should try it too. But I needed to build a convincing business case for the idea. And in doing this I used scenario manager.



I called up the hotel to get the details of the cost of hosting a full day training in their conference hall. I then went to work on the other costs that would be incurred in putting together the training. And below is the sheet of the cost details.
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And the underlying formulas are:
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As you can see, I have gotten every cost item listed; the estimated number of participants and the course fee too. But to build a convincing business case I need to create different scenarios. Maybe three scenarios.

	Scenario 1: The worst that could happen if we don’t market the training well and put the course fee enticingly low.

	Scenario 2: The most likely thing to happen if we do our regular marketing and put up a fair course fee.

	Scenario 3: What would happen if everything goes extremely well. Which will be our marketing aim.




So how do you set up this scenarios in Excel? You use Scenario Manager.



But first we need to use Named Range for the most important cells in our scenario. They are the Gross Profit cell, the Number of Participants cell and the Course Fee cell. In our scenarios we want to monitor what the Gross Profit will be for different combinations of Number of Participants and Course Fee.



I hope you remember how to do Named Range. You simply select the cell or range, go to the name box and type in the name you want to name the selection as.
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We do same for Course Fee.
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And for Gross Profit.
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Now, we launch the Scenario Manager.



It is under Data Menu, What-If-Analysis. 
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So let’s add the three different scenarios.



I’ll start with the worst. Click on Add and give the Scenario name as Worst. The cells we will vary are the Number of Participants and Course Fee cells.
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Click on OK. 

It will ask you to set the number of participants and course fee. So based on experience, I know that if we do no serious marketing and set the price to N45,000 we can get 20 people. And that is the worst that can happen.
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Click on OK.



Create a second scenario. Name it “Probable”. It will be what we will most likely achieve. Give the number of participants as 30 and the cost as N70,000. 



Finally, do the last scenario. Name it “Ideal”. It will be our marketing aim if we decide to go ahead with the training idea. Give the number of participants as 40 and the cost as N100,000



Once you are done, the Scenario Manager dialog box would look like the one below.
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Click on Summary. It will ask you for the Result cell to monitor. That is the Gross Profit cell.
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Click on OK.



You will be taken to a new sheet showing the comparison of the different scenarios.
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And as you can see, I now have a convincing case to show my partners and make them agree to organizing the one day training.



That’s how easy and powerful the Scenario Manager is.

Introduction To Excel VBA (macros)



A lot of people feel making macros in Excel is extremely hard and should be left only people who make a living from doing it full-time. If you are one of such people, I have a pleasant surprise for you. Macros in Excel are very easy and in the next five minutes I will guide you into making one.



So just before we start, let me do a brief explanation of what a macro is, why you might need to make one and the benefits of being able to make one.



Macros are simply a means of automating tasks in Excel. It’s no more than that. You might need to do it when you have a daily or weekly report you make that is of an unvarying standard format, input and output-wise. Having a macro can cut your analysis time from hours to 15 seconds. It’s like magic and everyone in your office will see you as a special being.



To be able to make macros, you need to make a small settings change in your Microsoft Excel.



Go to Files, Options and Customize Ribbon. Check the box beside Developer.
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Now you will be able to access the Developer menu.
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Also enabling the Macro record button which we will use in this introduction to Excel VBA.
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Next, I will show you how to create a macro by clicking the right button twice — the macro record button.



I have prepared a sample illustration data.
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It is fictitious table of Sales at an Autodealership by the different salesmen and the car make.



So the task I will use a macro to automate is a series of formatting steps. 



Note: For the gurus, it would be obvious that copy pasting format would have done the same thing our macro will do. Yes. But we have to do the illustration with something not too complex to confuse anyone. The good thing is that you will learn all the steps required to make any complex recorded macro you desire.



So here are the easy steps to creating a macro.



First, I select the month I want to manually do the formatting for and have the macro recorder save my steps.



[image:  ]



Click on the macro record button.



[image:  ]



Give the macro a name, a keyboard shortcut and a description.
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Click on OK.



Then begin doing the formatting steps. I change the font type, font color and add border, making it have our corporate color feel. Once I am done, I click on the stop recording button.
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And that’s all. We have created a macro. Next is to try it out and see it work.



Select another month’s record and press CTRL + k (the keyboard shortcut we used for the macro).
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Voila! It works!



So let’s insert a macro button. A button you will click to run the macro. I am sure you’ve seen one before. They are super easy to create.



Go to the Developer menu, Insert and select Button under Form Controls.
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Draw a rectangular button where you want the macro button to be. Immediately, Excel will ask you to select the macro to link it to. Select the macro we just created.
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Click on OK.



Then edit the name of the rectangular button.
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And that’s it! You’ve created a macro button.



Now select another month’s data and click on the macro button to see it work the magic we configured it for.
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See the result!
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Amazing, isn’t it?



I hope you are now convinced that creating a macro in Excel is very easy.



It’s now time for you to think up other creative ways to use a recorded macro.



Bonne chance!
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sales Report

pizza Type [Count of sales [sum of sales Amount

B8Q Chicken 310) #%620,000.00)

B8Q Philly Steak 301] %752,500.00)

Beef suya 314 %847,800.00)

[Chicken Bali

[Chicken Feast

[Chicken Legend

s/N Pizza Sold [sales Amount
1[Meatzaa #2,500.00)
2|Extravaganza #3,000.00)
3[8BQ Chicken #2,000.00)
4|Extravaganza #3,000.00)
5|Meatzaa #2,500.00)
6|Hot Veggie #2,200.00)
7|BBQ Philly Steak #2,500.00)
8|Chicken Feast #3,000.00)
9| Meatzaa #2,500.00)

[Chicken suya

10]

[Chicken suya

%2,500.00)

Extravaganza

Hot Pepperon Feast

1|

[Chicken Legend

%2,800.00)

12|

B8Q Philly steak

%2,500.00)

Hot veggie

13

[Chicken suya

%2,500.00)

italiano

Margarita

Meatzaa

Pepperoni Feast

Pepperoni suya

[veggie supreme

14| Chicken Feast #3,000.00)
15|Chicken Feast #3,000.00)
16[Beefsuya #2,700.00)
17|Chicken Feast #3,000.00)
18|Hot Veggie #2,200.00)
15| Meatzaa #2,500.00)
20|Veatzaa #2,500.00)
21[Vargarita #2,000.00)
22|italiano #2,000.00)
23[Hot veggie #2,200.00)
24]pepperoni Suya #2,500.00)

25|

[Veggie supreme

%2,200.00)

A

(TP S———

PO ——

= COUNTIFS(criteria_range, criterial, [criteria_range2, criteria2]..)

=SUMIFS{sum_range, criteria_range1, criterial, [criteri

_range2, criteria2], .






OEBPS/Images/image00208.jpeg
H > X v f
s c )

1SN |pizzasold [Sales Amount [Time.

2 1[Meatzaa 42,500.00]8:00:01 AM
3] 2[Extravaganza %3,000.00] 8:00:02 AM|
4 3[8BQ Chicken 2,000.00[8:00:04 AM
5 4lExtravaganza #3,000.00] 8:00:07 AM
5 5|Meatzaa #2,500.00] 8:00:08 AM
7 6|Hot Veggie #2,200.00]8:00:14 AM
8 7[BBQ Philly Steak #2,500.00[8:00:20 AM
9 8|chicken Feast #3,000.00]8:00:20 AM
10 o|Meatzaa #2,500.00]8:00:22 AM
1 10|Chicken Suya 2,500.00[8:00:25 AM
2 11[Chicken Legend 42,800.00] 8:00:26 AM
3 12[8BQ Philly Steak #2,500.00[8:00:27 AM
i 13|Chicken Suya #2,500.00]8:00:29 AM
15 14[Chicken Feast #3,000.00[8:00:33 AM
16 15|Chicken Feast #3,000.00]8:00:33 AM
7 16[Besf Suya #2,700.00] 8:00:34 AM
18 17|Chicken Feast #3,000.00] 8:00:35 AM
19 18[Hot Veggie #2,200.00] 8:00:35 AM
20 19| Meatzaa #2,500.00]8:00:35 AM
21 20|Meatzaa #2,500.00[8:00:36 AM
2 21| Margarita #2,000.00]8:00:37 AM

3 22| taliano #2,000.00] 8:00:40 AM
2 23/Hot Veggie 2,200.00[8:00:45 AM
2 2] #2,500.00] 8:00:45 AM

Pepperoni suya

=COUNTIFS(B1:85001,G3)

3 B G H )
sales Report
pizza Type [Count of sales [sum of sales Amount
B8Q Chicken 1:85001,G3) %620,000.00)
B8Q Philly Steak 301] %752,500.00)
Beef suya 314 %847,800.00)
Chicken Bali

counTFs

Crtra ranget | iBso01
arterat |63 =

{Pizza Sold™ Meatzaa* Extravagan.

“BBQ Chicken™

=30
Counts the number of cell specified by a given set of conditions or citeria

Criteria_range: is the range of cells you want evaluated for the particular condition.

Formula result = 310

Help on this fundtion
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14 Edo
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From = | michael@olafusimichael.com

iohn@colieaue com

Subject: The Analyzed Data for your actior|

Dear John,

Please find below the data we analyzed.

 Abia H1297498,300  M821,123,500 M1175454800  H967,327,400  N2,265,604,000  §4,584,916100
Adamawa 8,022792500  M4317,64,300  N1627,470,600  N1,023,694,700  #3,493,691,500  #1,5973,059,900
Akwalbom H820,782,800  #1,691,712,500 500 #2,187,626200  #2966,925400  K2,202,014,900 |
Anambra #2159322900  M1S1LE63,500  H4,060131900  N1843,665900  #2,439,308,800  #3,015,652900
Bauchi 764,708,600  M3,059451100  H2,879985,600  #3,032115500  #2609,030,900  #3,000,312,200
Bayelsa M1218646400  #2,035499,300  M3595177,500  §3,958,333,500  M4,856,865,900  #1,754,855100
Benue #3479,609,000  N3,864,832700  H24S8711,700  M4,801,142,000 2700421800  #3,212,451,900
Benue M602,469,700  M1387,315500  M4,501,134,600  H2728302,800  N1687,978,600  #3,627,716,800
Bomo 2361614200  H1616065000 #4,303,244,600  H4,216846800  HS81,980,000  H4,166,988,100
Cross River H2416592600  N197LE34600  M1814142400  N4,GS8AS7000  N745327,000  #4,779,952700

#a, 300 52,20 #3,361,514,600  #2,060, H4,671,269900  #2,363,220,900

43507140000  §3,233,069,500  #4,883253900  M1,060,164,800  #2,9265053,500  #713,048500

H2663501,000  W781461300  MAG266L800  H543,085200  H3,256,011,600  #2,300,705,300
Ll 116087900 84178943600 M1512170.300  #2.592.908100  M3340.038100  #4.040.341.600
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[ D 3

an-14 B reb-1a B viar-14 B2 Apr-14
H1297,498300  MB21,123,500  H1175454,800  #967,327,400
#4,022,792500  44,317,641,300  #1627,470,600  %1,023,694,700
MB2782,800  W1691712,500  84,927,386500  #2,187,626,200
#2150,32900  M1511,863,500  #4,060,131,900  81,843,665,900
M764748,600  #3,059,451,100  M2,879,985,600  #3,032,115,500
$1218,606400  42,035499,300  #3,596,177,500  ¥3,958,333,500
R3479,649,000  N3,864832,700  M2458711700  §4,801,142,000
#602469,700  #1387,315500  %4,501,134,600  #2,728,902,800
H2361,614200  N1,616065000  #4,908,244,600  84,216,846,800
$2416592,600  H1,971,834,600  #1814,142,400  M4,658,487,000
84755914300 §2,382,209,500  #3,361,514,600 K 2,060,298,000
#3,547,140,000  #3,233,069,500  #4,893,253,900  %1,060,164,800
H2663,501,000  M781461,300  N462661,800  #543,085,200
M1816,087,900  4,128943,600 #1512,170,300  %2,592,908,100
H1409,979200  H2,609372,800  #1990,645,300  83,219,650,200
#3,199,23200  42,063,317,300  #1829,381,400  ¥3,704,640,600
M620,111,300  #2,201,453,200 R 1885641400  #4,146,024,300
$2,501,742,600  M2,521,764,800  #2,013,994,900  84,994,515,700
H3550,126700  N1,573445100  #3,756,243,200  83,092,703,100
#3,933,598,800  M2,599,773,300  #1,224,845,400  M1,662,248,400
H2981,980,300  N2,021,735600  #3016518,600  K4,411,651,000
#3,585,021,500  N1,293,838700  MG638,877,300  82,969,721,400
R1684273,500  §4,790,202,900  N99L721500  N4,897,014,100
#2812,863,300  42,734,189,600  #2,306,601,300  #867,264,000
#3915338600  N1496830,100  #1305,509,900  84,919,941,300
#7319.183.000  N6.211689.500  #3.351178.500

#6.239.473.500

May-14 B un-1a

#2,265,644,000
#3,493,691,500
#2,966,925,400
#2,439,308,300
#2,609,020,900
#4,856,865,900
#2,700,421,800
#1,687,978,600

581,980,000

745,327,000
#4,671,269,900
#2,926,053,500
#3,256,011,600
#3,340,028,100
#1,893,090,400
#4,980,777,000
#2,551,023,100
#3,014,428,300
#1,417,963,700

450,931,500
#2,387,291,000
#1,025,989,500
#4,131,210,900
#2,104,687,400
£2,214,504,600

#11.610.307.000.

#4,544,916,100
#1,973,059,900|
#2,202,014,900
#3,015,652,900|
#3,000,312,200
#1,754,855,100|
#3,212,451,900
#3,627,716,300|
#4,166,988,100
#4,779,952,700|
#2,363,220,900

713,048,500
#2,900,705,900
#4,040,341,600|
#4,581,716,900
#2,520,202,900|
#2,523,019,700
#2,922,241,900|
#2,311,559,800
#3,835,345,400|

530,613,400
#2,648,689,500|
#3,990,418,100
#2,825,512,800|

#912,176,400

#22.681.984.500]
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NO02469,700
#2,361,614,200
H2,416,592,600
#4,755,914,300.
#3,547,140,000

§13,233,069,500

781,461,300
4128503600
#2509,372.800

2063317300

#2201,453,200
#2,521,764,800
#1573,445,100
2599773900
N2,021,735,600

#1,627,470,500
4,927,385,500
#4,060,131,900

#2,187,626,200
H1,843,665,900

W3,958,333,500
NaB01142,000
N2728,302,500
4,216,845,800
4,658,487,000
#2,060,298,000
1080,158,800

N 543,085,200
w2532908,
M3,219,650.200
3,704,640,600

4,934,515,700
3,092,703,100
162,248,300
4411651000

#3032,115,500
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FcT
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P

Jan-14
#1,297,498,300
#4,022,792,500

824,782,800
#2,159,322,900

764,748,600
#1,218,646,400
#3,479,649,000

602,269,700
#2,361,614,200
#2,416,592,600
#4,755,914,300
#3,547,140,000
#2,663,501,000
#1,816,087,900
#1,409,979,200
#3,199,223,200

620,111,300
#2,591,742,600
#3,550,126,700
#3,938,598,300
#2,981,980,300

Feb-14
821,123,500
#4,317,641,300
#1,691,712,500
#1,511,863,500
#3,059,451,100
#2,035,499,300
#3,864,832,700
#1,387,315,500
#1,616,065,000
#1,971,834,600
#2,382,209,500
#3,233,069,500
781,461,300
#4,128,943,600
#2,609,372,800
#2,063,317,300
#2,201,453,200
#2,521,764,800
#1,573,445,100
#2,599,773,900
#2,021,735,600

Mar-14
#1,175,454,800
#1,627,470,600
#4,927,386,500
#4,060,131,900
#2,879,985,600
#3,596,177,500
#2,458,711,700
#4,501,134,600
#4,908,244,600
#1,814,142,400
#3,361,514,600
#4,883,253,900

462,661,800
#1,512,170,300
#1,990,646,300
#1,829,381,400
#1,885,641,400
#2,013,994,900
#3,756,243,200
#1,224,843,400
#3,016,518,600

Apr-14
967,327,400
#1,023,694,700
#2,187,626,200
#1,843,665,900
#3,032,115,500
#3,958,323,500
#4,801,142,000
#2,728,502,800
#4,216,846,300
#4,658,487,000
#2,060,298,000
#1,060,164,800
543,085,200
#2,592,508,100
#3,219,650,200
#3,704,640,600
#4,146,024,300
#4,994,515,700
#3,092,703,100
#1,662,248,400
#4,411,651,000

May-14
#2,265,644,000
#3,493,691,500
#2,966,525,400
#2,439,308,800
#2,609,030,900
#4,856,865,900
#2,700,421,800
#1,687,578,600

# 581,980,000

745,327,000
#4,671,269,900
#2,926,053,500
#3,256,011,600
#3,340,028,100
#1,893,090,400
#4,980,777,000
#2,551,023,100
#3,014,428,300
#1,417,963,700

450,931,500
#2,387,291,000

Jun-14
#4,544,916,100
#1,973,059,900
#2,202,014,900
#3,015,652,900
#3,000,312,200
#1,754,855,100
#3,212,451,900
#3,627,716,300
#4,166,988,100
#4,779,952,700
#2,363,220,900

713,048,500
#2,900,705,900
#4,040,341,600
#4,581,716,900
#2,520,202,900
#2,523,019,700
#2,922,241,900
#2,311,559,800
#3,835,345,400

530,613,400





OEBPS/Images/image00121.gif
N

A 8 c D
First Name [Last Name |[Employee ID [Department
Mary Porter 1000058]

Joseph __|saliu 1000555 TS
Kenneth _|enny 1000588] 1T

Lekan __|jakes 1000585] Opertions
Gabriel _|Matthew 10005%0)






OEBPS/Images/image00120.jpeg
D2 - G2:66
A 8 c D & G
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2 [vary Porter 1000058/ G2:G6 2 HR
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5 [lekan  |rakes 1000583| Operations
6 [Gabriel _|Matthew 1000590] Marketing
7
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9 M| settings | input Message | Eror Alert
Go back

Validation crteria

] Apply these changes to all other cells with the same settings
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SIN pizza sold |sales Amount
1|Meatzaa #2,500.00[8:00:01 AM
2extravaganza %3,000.00[8:00:02 AM
3]8BQ Chicken #2,000.00[8:00:04 AM
4|Extravaganza %3,000.00[8:00:07 AM
5|meatzaa #2,500.00[ 8:00:08 AM
6|Hot veggie %2,200.00[8:00:14 AM
7|BBQ Philly Steak #2,500.00[8:00:20 AM
&|Chicken Feast %3,000.00[8:00:20 AM
5|Meatzaa #2,500.00[8:00:22 AM
10Chicken suya %2,500.00[8:00:25 AM
11[Chicken Legend #2,800.00[ 8:00:26 AM
12[88Q Philly steak %2,500.00[8:00:27 AM
13[Chicken suya #2,500.00[8:00:29 AM
14[Chicken Feast #3,000.00[8:00:33 AM
15|Chicken Feast #3,000.00[8:00:33 AM
16[Beef suya %2,700.00[ 8:00:34 AM
17]Chicken Feast #3,000.00[8:00:35 AM
18[Hot Veggie %2,200.00[8:00:35 AM
19|Veatzaa #2,500.00[8:00:35 AM
20[veatzaa %2,500.00[ 8:00:36 AM
21| Margarita %2,000.00[8:00:37 AM
2[taliano %2,000.00[8:00:40 AM
23[Hot Veggie #2,200.00[8:00:45 AM
24[pepperoni suya %2,500.00[ 8:00:45 AM

PR ey

"™ 2 200.00|

-00-48 AM|

=SUMIFS(C1:C5001,B1:85001,G3)

E | G H )
sales Report
pizza Type [Count of sales [sum of sales Amount
88Q Chicken 310[101,81:85001,G3)
B8Q Philly Steak 301] %752,500.00]
Beefsuya 314 %847,800.00|
Chicken Bali

SuMIFS

Sum_range | CiCS001

Ciiteria_ranget |B1:85001
Criteriat |63

‘Adds the cells specified by 3 given set of conditions o crteria,

{sales Amount’;2500;3000,2000;300.
{Pizza Sold Meatzaa Extravagan.

“BBQ Chicken™

‘Sum_range:  are the actual cels to sum.

Formula result = #520,000,00

Help on this fundtion
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state |Population |%age Value
Lagos | 16,768,590 26%
Kano 13,001,029 20%
Kaduna | 12,912,425 20%
Enugu | NA [ #vALUE!
Ogun 9,096,178 14%
Rivers 6,507,834 10%
Niger 6,193,390 10%
Total| 64,479,446 100%
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State  |Population _|%age Value
Lagos 16,768,590 26%
Kano 13,001,029 20%
Kaduna | 12,912,425 20%
Enugu | NA =
Ogun 9,096,178 14%
Rivers 6,507,834 10%
Niger 6,193,390 10%

Total| 64,479,446 100%
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Company Industry profit Margin
Mobil il & Gas. 23%]
Dangote Cement__|Manufacturing 15%
Access Bank Finance 10%
Julius Berger [Construction 15%
Oando il & Gas 23%]
Arik Air [airline 12%
NBC Food & Beverage 7%
Nigerian Breweries |Food & Beverage 10%
La Casera Food & Beverage 21%
Lafarge [Manufacturing 12%
GTBank Finance 23%]
‘Aero Contractors_|Airline 6%
Aiico Insurance__|Finance 7%
Berger Paints Manufacturing 25%)
Cadbury Food & Beverage 13%
Nestle Food & Beverage 23%]
3 [Manufacturing 21%
Unilever [Manufacturing 2%
Total il & Gas 22%)
First Bank Finance 14%
Dana Air [mirtine 1%
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2 Mobil il & Gas 23%
3 [Dangote cement_|manufacturing 15%
4 |Access Bank Finance 10%
5 [Julius Berger Construction 15%
6 (Oando 0il & Gas 2%
7 [Arik Air [Airline 12%
8 [NBC Food & Beverage 7%)
9 Nigerian Breweries |Food & Beverage 10%)

Merge8iCenter -~ 3 ~ % ? | o

Alignment r. Number

=AVERAGEIFS(C1:C22,81:822,"Airline")

D 3 F [

Airline Profit Margin Performance: 10%
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Edo

%2,663,501,000.00]

% 781,461,200.00]

% 462,661,800.00]

#543,085,200.00]

#3,256,011,600.00]

%2,900,705,300.00|

Ekiti

#1,816,087,300.00]

% 4,128,543,600.00|

%1,512,170,300.00]

#2,592,908,100.00|

3,340,038,100.00]

%4,040,341,600.00]

Enugu

#1,409,579,200.00|

%2,609,372,800.00]

#1,990,646,300.00]

%3,219,650,200.00]

#1,893,090,400.00|

% 4,581,716,900.00]

Fcr

%3,199,223,200.00]

#2,063,317,300.00]

%1,829,381,400.00]

% 3,704,640,600.00]

#4,980,777,000.00]

#2,520,202,300.00|

Gombe

% 620,111,200.00]

#2,201,453,200.00]

#1,885,641,400.00]

#4,146,02,300.00|

#2,551,023,100.00]

#2,523,019,700.00|

Imo

#2,591,742,600.00]

#2,521,764,800.00]

%2,013,994,300.00]

#4,994,515,700.00]

#3,014,428,300.00]

%2,922,241,300.00|

Jigawa

%3,550,126,700.00]

#1,573,445,100.00|

3,756,243,200.00]

%3,092,703,100.00]

#1,417,963,700.00]

%2,311,559,800.00]

Kaduna

% 3,938,598,800.00]

#2,599,773,300.00]

%1,224,849,400.00]

#1,662,248,400.00|

% 450,931,500.00]

3,335,345,400.00|
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A B C D E F G H
state Feb-14| Jun-14| Jan-14] Mar-14] May-14] Apr-14
| Abia %821,123,500.00] % 4,544,916,100.00| & 1,297,498,300.00| ¥ 1,175,454,800.00 ¥ 2,265,644,000.00| # 967,327,400.00|
[Adamawa | #4,317,641,300.00| # 1,973,059,900.00| % 4,022,792,500.00| & 1,627,470,600.00| # 3,493,691,500.00]  1,023,694,700.00|
Akwa Ibom | #1,691,712,500.00| # 2,202,014,900.00| # 824,782,800.00| ¥ 4,927,386,500.00| # 2,966,925,400.00| & 2,187,626,200.00|
[Anambra | #1,511,863,500.00| # 3,015,652,900.00| % 2,159,322,900.00| & 4,060,131,900.00| # 2,439,308,800.00|  1,843,665,900.00|
Bauchi % 3,059,451,100.00| # 3,000,3
Bayelsa #2,035,499,300.00) * 1,754,85!
Benue #3,864,832,700.00] 83,212,451| | “%| add Level || X Delete Level || R Copy Level Options. ¥ My data has headers
Benue | 41,387,315,500.00]_#3,627,711
Borno #%1,616,065,000.00 ¥ 4,166, e i e
Cross River | #1,971,834,600.00| #4,779,95] = b el [ et Newest x
Delta #2,382,209,500.00] * 2,363,2:
Ebonyi #3,233,069,500.00| #4713,
Edo % 781,461,300.00] ¥ 2,900,70!
Ekiti #4,128,943,600.00)  4,040,34!
Enugu | 42,609,372,800.00] #4,581,71
FcT 42,063,317,300.00]_§2,520,20] a
Gombe | #2,201,453,200.00] #2,523,01! ™ o Cancel
Imo #2,521,764,800.00) & 2,922,24! (SSTRE] z
Digawa | #1,573,445,100.00] 2,311,559,800.00] #3,550,126,700.00] % 3,756,243,200.00] # 1,417,963,700.00| #3,092,703,100.00|
Kaduna #2,599,773,900.00) # 3,835,345,400.00/ ¥ 2,938,598,800.00| & 1,224,849,400.00| % 450,931,500.00| # 1,662,248,400.00|
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B C D E F G H
rebvtd i prren ar 1 oy 10 pn

R 71125,5000 531610000 W 12975.90 0] 175 15,500 00 2255 5000 00] 07740000
31764130000 _41,97055500.00 02279 50,0 N 1627670600 00 345565150000 10263 70000
1517125000 _842.20016500.00] 4 526752.50.00] 5 4527556500 00 29555254000 257 25 0000
511865500004 3015 5250000 21593225000 5 060151500 00 24353050000 1546590000
N a05551100.0] 8300031 . .
205515530000 1758
[%3,864,832,700.00 %3,21285 | 4| aca Lever || XX Detete Level || B Copy Level Eotion: e e
Ni57515500 0] 352771 L .
N isi6 e 0000 Madgoas |
#%1,971,834,600.00] % 4,779,95. 24 e e
#2,382,209,500.00| #2,363,22 ] Case sensitive
e ae1 500 00] 200 e
1250856000 803038
Na5572000 00 8 8171
20855173000 252020
Naa01453200 00 257508 T
N2 a1 ess000] 29208
W 157545,100.0] 2,315 000 55501770 1| 37552052000 W LAT7 5657000 W30 73 00
2595773500004 35954540000 553559 3000 N 1220545400 00 450,551,500 1.662.248.400.00

Video 4 | Next Sheet @

)





OEBPS/Images/image00091.jpeg
2] Add Level

X Detete evel || Bz Copy Level

Opions.

My data has headers

Sorton

Order

[v] [FEEER [ v] [stoz

5

[v] [vates

[v] [atoz

5]






OEBPS/Images/image00090.jpeg
8 D 3 F
state Feb-14 Jun-14] Jan-14 Mar-14] May-14] Apr-14
Abia #821,123,500.00|_%4,544,916,100.00] % 1,297,495,300.00| ¥ 1,175,454,500.00| % 2,265,644,000.00| _#967,327,400.0)
Adamawa_| #4,317,641,300.00] W 1,973,059,900.00] %4,022,792,500.00] % 1,627,470,600.00 # 3,493,691,500.00| ¥ 1,023,64,700.00|
‘Akwa lbom | #1,691,712,500.00]_§2,202,014,900.00| _# £24,752,800.00] % 4,927,386,500.00] _ 2,966,925,400.00| ¥ 2,187,626,200.00|
Anambra_| #1,511,863,500.00  3,015,652,900.00] % 2,159,322,500.00] %4,060,131,900.00] _# 2,435,308,800.00| ¥ 1,843,665,500.00|

Bauchi | §3,059,451,100.00_%3,000,312,200.00] _# 764,745,600.00| ¥ 2,879,985,600.00| % 2,609,030,500.00] % 3,032,115,500.00)
Bayelsa | %2,035,499,300.00_#1,754,855,100.00] % 1,215,646,400.00| ¥ 3,596,177,500.00| #4,856,865,500.00]  3,958,333,500.00)
Benue | §3,864,832,700.00 % 3,212,451,900.00] % 3,475,649,000.00| ¥ 2,456,711,700.00| #2,700,421,800.00] % 4,801,142,000.00)

10 Benue | %1,387,315,500.00] W3,627,716,800.00| _# 602,469,700.00] %4,501,134,600.00 # 1,687,978,600.00] # 2,725,902,800.00|

11 Borno___| %1,616,065,000.00| 4,166,985,100.00] % 2,361,614,200.00 % 4,908,244,600.00] _# 561,980,000.00|  4,216,546,500.00]

Cross River | %1,971,834,600.00_#4,779,952,700.00] % 2,416,592,600.00| % 1,814,142,400.00| _# 745,327,000.00] % 4,658,457,000.0)
Delta 2,382,209,500.00_2,363,220,900.00] #4,755,914,300.00] % 3,361,514,600.00]  4,671,269,900.00| ¥ 2,060,295,000.00|
Ebonyi | ¥3,233,069,500.00| _#713,048,500.00] % 3,547,140,000.00| % 4,883,253,900.00| % 2,926,053,500.00] % 1,060,164,800.00)
Edo % 781,461,300.00_%2,900,705,900.00] % 2,663,501,000.00 _# 462,661,800.00| ¥ 3,256,011,600.00| _#543,085,200.00)
Ekitt #4,125,943,600.00_ 4,040,341,600.00] % 1,816,087,500.00] % 1,512,170,300.00 # 3,340,038,100.00| ¥ 2,592,505,100.00|
Enugu | %2,609,372,800.00 % 4,581,716,900.00] % 1,809,975,200.00| ¥ 1,990,646,300.00| #1,893,090,400.00] % 3,219,650,200.00)
o #2,063,317,300.00]_2,520,202,900.00] % 3,199,223,200.00] % 1,829,381,400.00| _# 4,980,777,000.00|  3,704,640,600.00|
Gombe | %2,201,453,200.00|_#2,523,015,700.00] _# 620,111,300.00| ¥ 1,885,641,400.00| % 2,551,023,100.00] % 4,146,024,300.00)
imo #2,521,764,800.00_2,922,241,900.00] % 2,591,742,600.00] % 2,013,994,900.00] # 3,014,428,300.00|  4,994,515,700.00|
21 ligawa | #1,573,445,100.00] % 2,311,559,800.00| ¥ 3,550,126,700.00| ¥ 3,756,243,200.00| % 1,417,963,700.00] % 3,092,703,100.00)
22 Kaduna | #2,599,773,900.00] #3,835,345,200.00| ¥ 3,938,595,800.00| ¥ 1,224,849,400.00| _#450,931,500.00] % 1,662,248,400.00)
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18
19
20
2
2

]
|

state Feb-14] Jun-14] Jan-14| Mar-14]
Imo #2,521,764,800.00|_#2,922,241,500.00| % 2,591,742,600.00| #2,013,994,500.00| _#3,014,428,300.00] % 4,994,515,700.00|

(Abia #821,123,500.00]_#4,594,516,100.00| #1,297,498,300.00| % 1,175,454,800.00] #2,265,644,000.00)

Lagos #7,319,183,000.00] # 22,681,984,500.00] # 6220-472- 700 nal a2 g 2z &

Kano %2,021,735,600.00| % 530,613,400.00)

ondo — L *3} Add Level || X Delete Level || ) Copy Level Options. My data has headers
Kogi %2,734,189,600.00|_#2,825,512,800.00) B

Benue | %3,864,832,700.00] %3,212,451,900.00] Order

For %2,063,317,300.00|_#2,520,202,500.00) V] [tz v
Ogun %2,586,000,100.00_#3,200,451,900.00|

Bayelsa | %2,035,499,300.00] %1,754,855,100.00]

Rivers | #4,860,256,800.00] %4,459,705,200.00]

(Anambra | %1,511,863,500.00]_#3,015,652,900.00)

Enugu %2,609,372,800.00_#4,581,716,500.00)

Benue | %1,387,315,500.00] %3,627,716,800.00]

Bormo #1,616,065,000.00_#4,166,988,100.00|

(Gombe | %2,201,453,200.00]_#2,523,019,700.00)

Katsina | #1,293,838,700.00] 2,648,689,500.00| #3,589,421,500.00] _# 638,877,300.00| #1,025,989,500.00] % 2,969,721,400.00]

Kaduna | %2,599,773,900.00] # 3,835,345,400.00| #3,938,598,800.00] % 1,224,849,400.00| _ %450,931,500.00] % 1,662,24%,400.00|

(Cross River | #1,971,834,600.00] %4,779,952,700.00| #2,416,592,600.00] % 1,814,142,400.00]__ % 745,327,000.00] % 4,658,487,000.00|

Kkwara %1,496,830,100.00| % 912,176,400.00| % 3,915,338,600.00| % 1,305,529,500.00| #2,214,504,600.00] % 4,915,941,300.00)
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HSve- &=

Sortingxds - Excel

Condiional Formatss el
Stes~
syt

e R T R ——
% cut [Catir o &8 == ¥ Swepte Gl B =
Faste B0 v p-A- === NegeRGenier~ | §-% 0 | A2
3 Fomat it Ue| B |Ro k- E== Vesge & Conte % 0 SR omattng- Tabe
b ot - sugnment A wmee
= s % [
A 5 3 o £ £ G
N interallyGenerated Revenueof States inNigeria |
2 [state Feb-14 Jun-14] Jan-14 Mar-14 May-14 Apr-14
3 [imo [ Wa521758,500 00| W2522,281,500,00] W2551,742,600.00] W 2.015,95500.00]_W5.01426,300.00] #3,954,575,700.00
4 [abi 821,123,500.00]_N.4,544,916,100.00] #1,257,436,300,00] N 1,175,154,800.00]_N 2,265,644,00000] N 967,327,400.00
s [Lagos | 97.515,195,000.00]  22,691.564,500.00] 45,235,475,500,00] M 6.211,689,50.00] W 11,610,307.000.00] #3,351,178,500.00
& [Kano [W2.021,75,60000] _m 530,613,400.00] 42,981,980,500.00] W ,016,516,600.00]_N2,367,291,000.00] W ,411,651,000.00
7 [ondo | W 1,690,422,800 00| 4,525,747,700.00] W 716,222.900,00] W 4,362.953,800.00]_W ,300536,300.00]_ N 577,676,300.00
5 [Kog [ W2.734,199,600.00]_W2.825,512,800.00] 42,512,663,500,00] W 2.306,601300.00]_W 2.104,657,400.00] W 867,26%,000.00
9 [Bende | W3,864,532,700 00|_3,212,451,500.00] 43,475,545,000,00] N 2.056,711,700.00|_N 2.700,421,800.00] #.4,801,142.600.00
10/FeT_[#42.063,517,300.00] #2.520,202,900,00] M 3,198,223,200.00] W 1,629,381,400.00|_#4.,580,777,000.00] 5,704,640,600.00
11 |Ogun [ 42,565,000,100.00]_#3.200,451,900,00] W 3,434,714,50.00] W ,507,557,500.00]_#2,265,022.600.00] 4 1,642,410,200.00
12 [Bayelsa | 42.035,459.300.00]#1.754,855,100.00] M 1,218,695,40.00] W 5,556,177,500.00]_#4.,856,865,500.00] 4,956,333,500.0
13 [Rivers | 194,860,256,800.00]_#14,455,705,200,00] W 2,423,028,500.00] W 4,148,805,900.00]_W3,882,664,300.00] _W855,715,700.00)
16 [Anambra | W1,511,863,500.00]#3,015,652,500,00] N 2,155,322,500.00] W1,060,131.500.00]_ W 2,435,305,800.00] 41,843,665,500.0
15 Enugy | W2,609,372,500.00]_#4,551.716,900,00] ¥ 1,409,57,20.00] W 1.550,6%6,300.00]_#41,593,050,400.00] 43,215,550,200.00
16 (Bonue [ #41,387,515,500.00]_#3,627,716,500,00] W 602,065,700.0] W.4,501,134,600.00]_ W 1,657,578,600.00] 42,725,902,800.0
17[Bomo | 41,616,065,000.00]_#44,166.965,100,00]  2,361,614,200.00] W.,505,245,600.00] M 581.960,000.00] ,216,846,800.00
18 Gombe [ 42,201,453,200.00] #2.523,015,700,00] M 520,111,300 W 1,885,641,400.00]_#2,551.023,100.00] 4 1,146,024,300.0
19 Katsina | 41,253,838,700.00]_#2,648,659,500,00] H3,585,421,500.00]_ 638,877,300 00| 1.025,585,500.00] #2.965,721,400.0
20 Kaduna | 42.599,773,500,00]_#43,535,345,400,00] W 3,998,59,500.00] W 1.28,549,400.00] _ W 450,931.500,00] 4 1,662.248,40000)
21 [Cross River | W1,971,634,600/00]_#4,779,952.700,00] M 2,16,592,600.00 W 1,514,142,000.00] M 745,327,000.00] 4,656,487,000.0
22 kwara | 41,496,830,100.00] _N512,176,400,00] ¥ 3,915,338 500.00] W 105,529 500.00] 4 2.216,504,600.00] #4915,941.300.0)
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2 state Feb-14] Jun-14] Jan-14 Mar-14] May-14] Apr-1a]
imo §2,521,764,800.00]_#2,922,241,900.00] ¥ 2,591,742,600.00] §2,013,954,900.00]_# 3,014,428,300.00] §4,954,515,700.00)
4+ [Abia M521,123,500.00]_#4,544,916,100.00] ¥ 1,297,495,300.00] M 1,175,454,800.00]_#42,265,644,000.00] ¥ 967,327,400.00
Lagos | 7,319,183,000.00] W 22,681,984,500.00] M 6,235,473,500.00] N 6,211,685,500.00] W 11,610,307,000.00] M 3,351,178,500.00
5 [Kano N2,021,735,600.00] _ M'530,613,400.00] N 2.951,980,300.00] W 3,016,518,600.00] N 2,387,291,000.00] N 4,411,651,000.00)
7 ondo N1,690,422,800.00] N4,925,747,700.00] N 715,222,900.00] N,362,953,800.00] N 4,300,936,900.00] N 977,876,300.00
8 [kog: #2,734,189,600.00]_#2,825,512,800.00] # 2.612,863,300.00| 1 2,306,601,300.00] #2,104,687,00.00| 4 867,264,000.00,
9 Benue | %3,864,832,700.00] N 3,212,451,500.00] M 3,475,645,000.00] N 2,458,711,700.00] N 2,700,421,800.00] §4,801,142,000.00
10 FcT 2,063,317,300.00]_#2,520,202,900.00]  3,199,223,200.00] #1,829,381,400.00]_# 4,980,777,000.00]  3,704,640,600.00)
11 [ogun 42,586,000,100.00]_83,200,451,500.00] N 3,34,714,500.00] 3,907,557,600.00] M 2,265,022,600.00] N 1,642,410,200.00|
Bayelss | M2,035,495,300.00] M 1,754,855,100.00] M1,218,646,400.00] W 3,596,177,500.00] M 4,856,865,900.00] N 3,58,333,500.00
13 [Rivers | N4,860,256,800.00] M 4,459,705,200.00] m2.423,028,900.00] N ,148,808,900.00] 14,882.,684,300.00] m859,719,700.00
14 [Anambra_| N1,511,863,500.00] #3,015,652,900.00] #2,159,322,900.00] N 4,060,131,900.00] #2.439,308,800.00] M 1,843,665,900.00
15 [Enugu | 92,609,372,800.00] #4,581,716,900.00] #1,405,575,200.00] %1,990,646,300.00] #1.893,090,00.00] #3,219,650,200.00
16 Benue | %1,367,315,500.00]_#3,627,716,800.00] _ 602,469,700.00] 4,501,134,600.00|  1,687,578,600.00] N 2,725,902,800.00
17 Bomo | #1,616,065,000.00_#4,166,988,100.00]  2,361,614,200.00] 4,908,244,600.00 __ 531,580,000.00] §,216,846,800.00
18 Gombe | %2,201,453,200.00] N2,523,015,700.00] _ 620,111,300.00] ¥ 1,885,641,400.00| N 2,551,023,100.00] W2,146,024,300.00
7 [Katsina | 91,293,835,700.00] #2,645,689,500.00| M3,585,421,500.00] N 638,877,300.00] 4 1.025,98,500.00] M2,969,721,400.00
20 [Kaduna | N2,599,773,900.00] M 3,835,345,400.00] M3,938,59,800.00] N 1,224,845,400.00] M £50,931,500.00] N 1,662.248,400.00
21 [Cross River | W1,971,834,600.00] W 4,779,952,700.00]  2.416,592,600.00| M 1,814,142,400.00] W 745,327,000.00] 1 ,658,487,000.00]
Kwara | 1,496,830,100.00] 4 912,176,400.00] #3,915,338,600.00] % 1,305,525,900.00] #42.214,504,600.00] #4,515,941,300.00
Niger | %4,592,318,900.00] #1,826,747,300.00] #3,002,387,100.00] #3,219,870,900.00]_#3,575,805,300.00] #1,086,324,400.00
‘Akwa lbom | #1,691,712,500.00_#2,202,014,500.00 _ 524,782,800.00| #44,927,386,500.00] #2,966,925,00.00| # 2,187,626,200.00)
Plateau | 42.371,220,000.00] #4,894,816,200.00] %4,527,323,100.00] %2,471,653,300.00]_#3,593,441,000.00] ¥ 932,775,800.00
Taraba N 785,603,400.00] M3,244,525,900.00] M 531,245,900.00] W 2,475,480,400.00] 1 1.38,455,200.00] M 878,820,400.00
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1 UrBizEdge Employees Biodata Table

2 [First Name [Last Name [Employee ID [Sex [Employment Date |Phone Number |Contact Ad
3 | Michael Olafusi 1000001 |M 21-Oct-13/08089382423 |21, Adigun
4 |John Abiola 1000002 |M 1-Apr-14(08080810251 |21, Adigun
5 Mary Eze 1000003 |F 1-Apr-14(08080810252 |21, Adigun
6 | Segun Owolabi 1000004 |M 1-Apr-14(08080810253 |21, Adigun
7 |Tolu Owoeye 1000005 |F 1-Apr-14(08080810254 |21, Adigun
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